Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, MediaShow IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH MediaShow AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

MediaShow is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address
CyberLink Corporation
15F, #100, Minchiuan Road, Shindian City
Taipei 231, Taiwan

Web Site
www.cyberlink.com

Telephone
886-2-8667-1298

Fax
886-2-8667-1300

Copyright © 2009 CyberLink Corporation. All rights reserved.
# Contents

## Introduction ....................................................... 1
Welcome .................................................................................................................... 1
What’s New .......................................................................................................... 2
MediaShow Versions ........................................................................................ 2
MediaShow Modules ....................................................................................... 3
System Requirements ........................................................................................... 4

## Managing, Viewing and Editing Media .......... 7
Managing Media in MediaShow ........................................................................ 7
   Using the Library ............................................................................................... 8
   Tagging Faces ...................................................................................................13
Viewing Media in MediaShow ..........................................................................15
   Media Window .................................................................................................15
   Tray .......................................................................................................................16
   Viewing Photos and Videos .........................................................................16
Editing Media in MediaShow ............................................................................18
   Trimming Videos .............................................................................................19
   Making Photo Fixes ........................................................................................19
   Making Video Fixes .........................................................................................20
   Fine Tuning Photos and Videos ....................................................................20
   Adding Photo Effects ......................................................................................20
   Viewing the Edit Log ......................................................................................21
   Adding Descriptions and Tags ...................................................................21
   Renaming and Resizing Media .....................................................................21

## Creating New Media ....................................... 23
Using Your Photos ................................................................................................23
Contents

Technical Support .................................................. 49
Before Contacting Technical Support .................................. 49
Web Support ........................................................................................................... 50

Index ......................................................................................................................... 51
Chapter 1:

Introduction

This chapter introduces CyberLink MediaShow, outlines the latest features, and reviews the minimum system requirements for the program.

Note: this document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of software programs. CyberLink MediaShow provides an innovative way to use all of your digital media. With CyberLink MediaShow you can import all of your photos and videos into the easy-to-use program and then view, edit, and organize them to your liking. You can then
create dynamic slideshows with your photos and videos, or custom movies with all of your video clips, and a whole lot more.
Once it is ready, share your digital media with the world by uploading it to Flickr, Facebook or YouTube, e-mail it to friends and family, or burn it to a disc in a variety of formats.

What’s New

This section outlines the latest features within the CyberLink MediaShow program.

• Tag people’s faces in your photos.
• Import PowerPoint files and convert them to JPG files.
• Enhanced slideshow designing, including the ability to add videos, text and color boards to your slideshows.
• View the editing history for each media file, and instantly roll back changes to a specific modification.
• Upload your photos and videos directly to Facebook.
• Convert videos into many popular formats, including formats compatible with an iPhone, iPod, Zune, Xbox, PS3 and more*.
• Create discs with your photos and videos in the DVD format.

---

Note: * optional feature in CyberLink MediaShow. Check the readme file for detailed versioning information.

MediaShow Versions

The features that are available to you within CyberLink MediaShow are completely dependent on the version you have installed on your computer. File format support, media creating features, and other features vary depending on the version that you have. Check the readme file for detailed versioning information.

To determine the version and build number of your installed program, click on and then select About MediaShow from the menu.
Upgrade Your Software
Software upgrades are available from CyberLink. To upgrade your software, click the button within the program. The upgrade window displays where you can download new upgrades and updates for CyberLink MediaShow.

**Note:** you are redirected to CyberLink’s cyberstore if you choose to purchase an upgrade. You must connect to the Internet to use this feature.

MediaShow Modules
CyberLink MediaShow has four separate modules that let you perform a variety of tasks.

<table>
<thead>
<tr>
<th>Modules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photos</td>
<td>In the photos module, you can organize, view and edit your photos, create slideshows, screen savers, and more.</td>
</tr>
<tr>
<td>Videos</td>
<td>In the videos module you can organize, view and edit your videos, create movies, and more.</td>
</tr>
<tr>
<td>Create Disc</td>
<td>The create disc module lets you create discs with your media in a variety of formats, complete with stylish menus. Select <strong>Disc</strong> on the launcher to open this module.</td>
</tr>
<tr>
<td>Video Converter*</td>
<td>Within the video converter module, you can quickly convert videos into other file formats. Select <strong>Convert</strong> on the launcher to open this module.</td>
</tr>
</tbody>
</table>

**Note:** * optional feature in CyberLink MediaShow. Check the readme file for detailed versioning information.
To open a specific module, select it from within the launcher window.

You can also open certain modules from within different areas inside the program. For example, you can quickly switch between the photos and videos module by selecting the **To Photos/Videos** button on the **Home** tab.

## System Requirements

The system requirements listed below are recommended as minimums for running CyberLink MediaShow.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
</tr>
<tr>
<td>• Windows 7/ Vista/XP (Service Pack 2).</td>
</tr>
<tr>
<td>• DirectX 9 or above.</td>
</tr>
<tr>
<td><strong>Screen Resolution</strong></td>
</tr>
<tr>
<td>• 800 X 600, 1024 X 576, 16-bit color or above.</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>• 1 GB required (2 GB and above recommended for HD video).</td>
</tr>
<tr>
<td><strong>HDD Space</strong></td>
</tr>
<tr>
<td>• 1GB required.</td>
</tr>
<tr>
<td>• 10 GB (20 GB recommended) required for DVD production.</td>
</tr>
</tbody>
</table>
## Minimum System Requirements

<table>
<thead>
<tr>
<th>Category</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| **CPU**             | • Intel Pentium D 3.0 GHz CPU with hyper threading or equivalent AMD CPU is minimal.  
                      • MPEG-2 HD Profiles: Pentium Core 2 Duo E6400 or Athlon 64 X2 5000+ and above.  
                      • CyberLink MediaShow 5 is optimized for CPU with MMX/SSE/SSE2/3DNow!/3DNow! Extension/HyperThreading/Dual Core technology. |
| **VGA**             | • Minimum Intel 945 GM and above.  
                      • Minimum Nvidia Geforce 6600 and above.  
                      • Minimum ATI X1600 and above.  
                      • 64MB-VRAM and above.  
                      • Some animation effects may be turned off or degraded for lower end graphics system. |
| **Burning Device**  | • A DVD burner (DVD+R/RW or DVD-R/RW) is required to burn DVD content. |
| **Printers**        | • All printers                                                              |
| **Internet Connection** | • An Internet connection is required for the upload and download features. |
| **Import Device**   | • Cameras via removable disk interface.  
                      • Cameras support Windows Portable Devices interface. |
Chapter 2:

Managing, Viewing and Editing Media

This chapter outlines the methods for managing, viewing and editing your photos and videos in preparation for using them to create other media and share them with your friends and family.

Managing Media in MediaShow

When you open the photos or videos module, the program appears as follows:

A - MediaShow Menu, B - Albums, C - Feature Tabs, D - Library, E - Function Buttons, F - People Search, G - Search, H - Tray, I - Thumbnail Slider, J - Media Window, K - Folders, L - Tags, M - People
Note: the features and functions available differ between modules. Select the To Photos/To Videos button on the Home tab to switch between the two main modules.

Using the Library

When you import your photos and videos into CyberLink MediaShow, they are automatically categorized into a series of folders for easy browsing within the library. The library also categorizes your media into albums, by search tags, and within the photos module, by the people in your photos.

The library consists of the following sections:
- Albums
- Folders
- Tags
- People

Importing Additional Media into the Library

The first time you launch CyberLink MediaShow, you are guided through a wizard that assists with the import of the media on your computer’s hard drive. All of the folders specified in this wizard are monitored and any new media added to them is automatically imported into the media library.

If there is some media that was missed or is on a disc or a removable device (such as a digital camera or camcorder), use the import window to import it into CyberLink MediaShow.

Note: you can also just drag and drop photos and videos into the CyberLink MediaShow window to import them into the program.

Importing Photo and Video Files

To import additional media, including PowerPoint slides, into CyberLink MediaShow, do this:
1. Click the Import button on the Home tab. The import window displays.
2. Select the Import Media button and then select the location of the media that you want to import. Depending on the devices connected to your computer, you can select a removable device (digital camera or other device), optical disc drive, folder on your hard drive, etc., from the list. In the photos module, select
**Import and Convert PowerPoint File** to browse for and convert the slides in a PowerPoint file into images in the JPG format.

3. Once you select your import source, the content of the folder, device, disc, etc. displays in the Import Tray section of the import window. Select a media file to preview it in the Preview section of the window.

4. Click **Import All** to import all of the media in the Import Tray or select the specific media file you want to import and then click **Import Selected**.

**Note:** select **Exclude duplicates** to have CyberLink MediaShow ignore the media that was previously imported into the library.

5. Enter the required information into the Importing Media window, including where on your computer’s hard drive you want to store the imported media, and then click on **OK**.

6. Click on **Done** when the import is complete and then click on **Back** to return to CyberLink MediaShow’s main window.

**Note:** select Background Import if you want to hide the importing media status dialog and continue using CyberLink MediaShow.

**Importing from a DV or HDV Camcorder**

To capture and import video from a DV or HDV camcorder, do this:

**Note:** these steps outline how to capture and import video from camcorders connected with an IEEE (firewire) cable. If your camcorder connects to your computer via USB, you can import the video files directly by selecting **Import Media** and then selecting your camcorder from the list of attached devices.

1. Click the **Import** button on the **Home** tab. The import window displays.

2. Select:
   - **Import from DV** and then your camcorder from the drop down to capture and then import videos from an attached DV camcorder.
   - **Import from HDV** and then your camcorder from the drop down to capture and then import videos from an attached HDV camcorder.

3. To:
CyberLink MediaShow

- capture and import all of the video on your camcorder, select **Import All**.
- capture and import a specific portion of the video, use the playback controls to find the starting point of the content and then select **Start Import**.
4. Enter the required information into the Importing Media window, including where on your computer’s hard drive you want to store the captured video, and then click on **OK**.
5. If capturing a clip, select **Stop Import** when you want to stop capturing.
6. The captured video displays in the Import Tray and is automatically imported into your media library.

**Albums**

You can create new albums or place your media into existing ones, helping you organize your media and prepare it for screen savers, slideshows, movies, discs, etc.

**Note:** when you add media to your favorites, it is placed into the **Favorite Media** folder within albums automatically.

Select **Album Tools** on the CyberLink MediaShow feature tabs to:

- Add a **New** album.
- **Edit** existing album information.
- **Sort** media by date, modified date, name or file size.
- **Delete** an album from the library.

You may also create a new album by doing one of the following:

- Right-click within the albums section and select **Create a New Album**.
- Click on the button within the albums section of the library.
- Right-click on an item in media window and select **Add to Album > Create a New Album**.

Once you have added a new album, enter in a name and description for the album in the window that opens.

To add media to an album, do this:

- right-click on the media and select **Add to Album** and then select the album from the list.
- drag and drop your media directly into the album.


Note: see "Creating a Screen Saver" on page 25 for more information on the Screen Saver album.

Favorites
CyberLink MediaShow lets you add the photos and videos you like the most to your favorites. When you add media to your favorites, it is added to the Favorite Media folder in albums, where you can easily view them or add them to a slideshow, disc, or share them with friends and family.

To add media to your favorites, do one of the following:
- select the media files you want to add in the media window and then click on the button.
- while viewing a slideshow or video, click on the button.
- drag and drop media into the Favorite Media folder in albums.

Folders
When your media is imported into CyberLink MediaShow, it is automatically organized by year and the corresponding folders on your computer’s hard drive in the folders section of the library.

Note: media located on removable drives and optical discs are not displayed in the folder list.

Use the Folders Tools on the CyberLink MediaShow feature tabs to:
- Edit existing folder information.
- Sort media by date, name or file size.
- Locate the folder on your hard disk.
- Delete a folder and its contents from your computer’s hard drive.
- Hide a folder from view within the library.

You can also edit a folder’s information by right-clicking on it in the library or the media window and then select Edit Folder Information. Sort the media within a folder by right-clicking in the library and selecting Sort by.

You can re-organize folders within the library via one of the following methods:
- Right-click on a folder and select Separate by Date to create new folders based on the dates each media file was created.
Right-click on a media file within a folder and select *Separate Folder Here.* CyberLink MediaShow creates a new folder that includes the media from the position where you clicked.

Select one or more media files, right click and then select *Move to New Folder* to create a new folder containing only the selected media.

To add a folder into the library that CyberLink MediaShow will scan and monitor for media, do this:

- Click on the button within the folders section of the library.
- Select the *Add Folder* button on the *Home* tab.

See "Library Preferences" on page 45 for detailed information on selecting and setting the preferences for the folders you add into the library.

**Tags**

You can add search tags to your photos and videos within CyberLink MediaShow, which can help you find them later when searching through all of the media within the library. Search tags are also useful when uploading media to Flickr and YouTube, as users search by tags to find media they are interested in.

Use *Tag Tools* on the CyberLink MediaShow feature tabs to:

- Add a *New* tag.
- *Edit* an existing tag.
- *Sort* media by date, name or file size.
- *Delete* a tag.

To create a new tag, do one of the following:

- Click on the button within the search tags section of the library.
- Right-click on the tags section and select *Add a New Tag*.
- Right-click on an item in the media window and select *Add Tag > Add a New Tag*.

Once you have added a new search tag, enter in a name and description of the tag in the window that opens.

To add search tags to your media, do this:

- Right-click on the media and select *Add Tag* and then select the tag from the list.
- Drag and drop your media into a tag within the search tags section.

**Note:** you can add more than one search tag to a single photo or video.
People
When you tag faces within your photos, they are added to the people section of the library. For more information see "Tagging Faces" on page 13.

To add a new person, do one of the following:
- Click on the button within the people section of the library.
- Right-click on the people section and select Add a New Person.

Once you have added a new person, enter in his or her name and then a description about the person in the window that opens. You can edit this personal information at any time by right-clicking on the person in the library and then selecting Edit Person’s Info. Once you have tagged the added person in photos, set a photo as the default photo for the person.

Sort the photos for a person by right-clicking in the library and selecting Sort by.

Tagging Faces
CyberLink MediaShow lets you tag all of the faces of your friends and family in your photos. You can manually tag the faces in each photo, or have CyberLink MediaShow auto detect and tag the faces for you.

Once the faces are tagged, the photos are then categorized in the people section of the library.

Auto Tagging Faces
CyberLink MediaShow uses face recognition to auto detect and tag faces in your photos. To have CyberLink MediaShow auto scan a group of photos for faces, do this:

1. On the Home tab, select Tag Faces.
2. Select which photos you want to tag faces in. You can select all of the photos in the library, or a specific group of photos, such as in a folder or those held on the tray.

Note: if your computer's VGA card supports CUDA technology and there are enough resources available, select Enable CUDA support for face analysis to reduce the time it takes to analyze your photos.

3. Once you have selected the photos, click Start. CyberLink MediaShow will begin to analyze them for faces.
Organizing Tagged Faces
Once faces are tagged in your photos, CyberLink MediaShow groups similar faces in the Tag Faces window. In this window you can go through each face and associate it with a person in your library, or add a new person. You can also remove any unnecessary tags or skip faces if you want to add them later.

To associate a person to a tagged face:
- click on Select and then select the person from the list,
- click on Select and then on New to create and associate a new person in your library.
- click the button with the name of the suggested person.
- click Skip to tag the person later.
- click Remove to remove the tag from the photo. You can also deselect the check box to remove the tag from the photo.

Editing People
In the Tag Faces window, you can also add new people to your library, edit the person's personal information, and even scan the rest of your media for photos of this person.

To edit people in the Tag Faces window:
- select to edit the person's personal information and associate a default photo for him or her.
- select to remove this person from the library.
- select to scan the rest of the photos in the library for photos of this person.

Manually Tagging Faces
If CyberLink MediaShow missed faces during the auto scanning process, you can manually tag faces in your photos.

To manually tag faces, do this:
1. Select an album, folder, search tag, or select and hold all of the photos on the tray.
2. Click the Edit button on the Home tab.
3. Select the photo in the thumbnail panel that you want to tag a face in and then select Tag Faces.
4. Click on Add Tag.
5. Drag the square to the position in the photo where the face is located.
6. Resize the square if required and then click on **Unknown**.
7. Select an existing person from the list or select **New** to add a new person to the library.
8. Repeat the process to tag other faces in the photo. Select **Done** when you have tagged all the faces in the photo.

**Viewing Media in MediaShow**

CyberLink MediaShow acts as an all-in-one digital media player, for viewing both your photos and videos.

**Media Window**

The media window contains thumbnails of all the media imported into your CyberLink MediaShow library. You can dynamically resize the thumbnails in the media window by:

- using the thumbnail slider in the bottom right corner of the window.
- clicking on the **View tab**, selecting the ** Thumbnails** button, and then select the desired thumbnail size.

**Searching for Media**

If you cannot find a specific media file or folder in the media window, use the search functions to assist in your search.

To search for photos with people in them:

1. Select the ** button.
2. Enter the name of the person you are searching for and/or select them from the list.
3. Select **OK** to filter the results and display any photos with this person in them.

To search for media using search tags, folder names, etc.:

1. Enter in a search keyword in the search field located in the top right of the program window.
2. CyberLink MediaShow filters the media files within the media window based on the keyword
Select **Cancel Search** to return the media window to the regular view and display all of your media content.

**Tray**

The tray is a convenient little area that lets you temporarily hold media you want to add to an album, play in a slideshow, include on a disc, export to a folder, etc. When you are browsing through your media, click on a photo or video to display its thumbnail on the tray. If you would like to hold it on the tray for future use, click on + . The item is held on the tray until you select it and click on the \(-\) button.

Once you are holding all the media on the tray that you want to use, select the \(+\) button to add the media files to an album or export them to a folder on your hard drive.

---

**Note:** the media files being held on the tray are automatically included or delivered for you when you enter the edit window, create a slideshow, create a disc, etc.

**Viewing Photos and Videos**

You can quickly view any photo or video in your library by double-clicking on it in the media window. Use the slider on the right of the playback controls to dynamically resize the photo or video to a desired size.

When viewing a video, CyberLink MediaShow plays all of the videos being held on the tray. When viewing a photo, it displays in a paused slideshow. Select the play button to instantly play a slideshow with all of the photos in the current folder, album, or being held on the tray.

When playing a slideshow or a video, the following controls are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⏹️</td>
<td>Stops the slideshow/video and returns to the main window.</td>
</tr>
</tbody>
</table>
## Chapter 2: Managing, Viewing and Editing Media

<table>
<thead>
<tr>
<th><strong>Button</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>When viewing a slideshow, click this button to select the desired slideshow style. See &quot;Slideshow Preferences&quot; on page 44 for a detailed description of the slideshow styles.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to configure the media file's playback preferences. You can select the speed CyberLink MediaShow plays the media and whether you want to <strong>Display Captions</strong> during the slideshow. Select <strong>Loop</strong> for continuous playback of the media and <strong>Shuffle</strong> to display media in random order. When viewing a slideshow, click <strong>Select Background Music</strong> to select a song to use as background music and <strong>Match to Background Music Length</strong> to set the slideshow duration to match the length of the music selected. If you are viewing a cell slideshow, select <strong>Change Slideshow Opening</strong> to modify the opening page at the beginning of the slideshow.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Returns to the previously viewed photo or video file, if available.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Starts the playback of the slideshow or video.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Pauses the playback of the slideshow or video.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Jumps to the next photo in the slideshow or video file on the tray, if available.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click the <strong>Favorites</strong> button to add or remove the current photo or video you are viewing to/from your favorites.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to rotate the current photo or video in the counterclockwise direction.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to rotate the current photo or video in the clockwise direction.</td>
</tr>
</tbody>
</table>
CyberLink MediaShow offers several editing features, including adding creative
effects to your photos, trimming unwanted portions from video clips, or
performing various touch ups on both photos and videos in preparation for using
your media in slideshows, movies, discs, etc.

Note: you can easily undo any edits that you make to a photo or video by right-clicking on it
in the media window and selecting **Undo Changes**. You can also use the **Edit Log** to roll
back changes to a specific version. See "Viewing the Edit Log" on page 21 for more
information.

To open the edit window:
- select the photo or video you want to edit in the media window and then click
  on the **Edit** button on the **Home** tab.
- right-click on a photo or video and then select **Edit**.

Note: any photos or videos that are being held on the tray, also appear in the edit window
thumbnail panel.

When editing a photo, select the **Compare** button to view all of the changes you
make to your photos side by side. Click the **Rotate Left** or **Rotate Right** button to
adjust a photo or video's orientation.

To resize the viewing size of a photo or video:
• select 1:1 to view the photo or video at actual size.
• select F to fit the photo or video within the working area.
• select P to view the photo or video at full screen.
• use the slider on the bottom right to dynamically resize the photo or video to the desired size.

**Note:** to view detailed information about a photo or video in the edit window, click on the Info button.

### Trimming Videos

Select Trim within in the video edit window to remove the portions of a video that you don’t want in a final movie or slideshow. Use the helpful tips on the user interface for a detailed description on how to use the trim function.

### Making Photo Fixes

CyberLink MediaShow provides you with several common fixes for your photos, including automatic fixes, fixing red-eye and a photo cropping feature. Click on the Edit button and then on the tab to perform the following fixes on your photos.

- **Crop:** allows you to crop the photo and cut out the portions you don’t want. Select a Fixed ratio to crop a specified size out of the photo. Select Invert to reverse the size of the fixed area.
- **Red-eye:** use this option to remove unwanted red-eye from your photos.
- **Straighten:** if your photo was taken unevenly and appears to be crooked, select this option to make it more level.
- **Auto Brightness:** select to automatically adjust the photo’s brightness.
- **Auto Contrast:** select to automatically adjust the photo’s contrast.
- **Auto Balance:** select to automatically adjust the photo’s color balance.
- **Auto Fix Lighting:** select to automatically fix the lighting within the photo.

Select Done to save the changes to your photo.
CyberLink MediaShow

Making Video Fixes

CyberLink MediaShow provides you with several common required quick fixes for your videos, including fixing the lighting, correcting shaky video, and reducing audio and video noise. Click on the Edit button and then on the tab to perform the following fixes on your videos.

- **Fix shaky video**: select to automatically fix a video clip that contains moments where the camera is shaking.
- **Auto fix lighting**: select to automatically fix the lighting within the video.
- **Reduce video noise**: select to reduce any video white noise or remove blocky artifacts from a video clip.
- **Reduce audio noise**: use this option to filter out background noise from the audio track. Drag the slider to remove more or less noise.

Once you are done selecting all the fixes you want to make to your video, select:

- **Preview Selected Fix** to view a preview of how the fix affects the video.
- **Apply Selected Fix** once you are satisfied with the results.

Fine Tuning Photos and Videos

Use the fine tune function if you want to manually adjust the **Brightness**, **Contrast**, **Saturation**, **White balance** or **Sharpness** (for photos only) of your media. Click on the Edit button and then on the tab to use the sliders to adjust the media file’s properties. Select **Done** to save the changes.

Adding Photo Effects

CyberLink MediaShow lets you add display and color effects to your photos. Click on the Edit button and then on the tab to add the following effects to your photos.

- **Black & White**: changes color photos into black and white photos.
- **Sepia**: applies a dark brown-grey hue that resembles the effect of aging in old photographs.
- **Matte**: adds a white matting to your photo. Click and drag the focus to the area you want to apply the matting, and then use the slider to increase or decrease its size.
- **Vignette**: using the slider closes/opens a black circle on your photo, like in old silent movies.
• **Soft Focus**: adds a soft focus effect to your photo. Use the Size slider to adjust the focus area and the Soft slider to adjust the amount of blur.

• **Focal B&W**: the focal black and white effect lets you have some portions of a photo in color, while others are in black and white. Use the slider to adjust the area that you want to display color.

• **Tint**: the tint effect lets you add highlighted color throughout your photo. Pick your desired color and then use the slider to adjust the intensity.

• **Glow**: the glow effect makes all the lighter areas of a photo appear to glow.

• **Antique**: the antique effect gives your photo an old fashioned look, as if it was taken more than 50 years ago.

Select Done to save the changes to your photo.

**Viewing the Edit Log**

Click on the Edit button and then on the Edit Log tab, or just on the Edit Log button, to view a history of all the edits made to the selected photo or video within CyberLink MediaShow.

Select Original File to undo all the changes you made to the media file. You can also select any of items in the edit log list to reset the changes to that point in the media file's edit history.

**Adding Descriptions and Tags**

CyberLink MediaShow lets you add descriptions and search tags to your photos and videos within the edit window.

- To add a caption description that displays, when enabled, during playback and in slideshows, click the button or just click and type in the space below the photo or video.
- To view and add search tags to a photo or video, click on the Tags button. See "Tags" on page 12 for more information.

**Renaming and Resizing Media**

Within CyberLink MediaShow you can resize your photos, or rename one or more photos or videos. To do this, select the media files you want to modify, click on and then select Rename or Resize (for photos only) from the menu.
Chapter 3:

Creating New Media

This chapter guides you through the different creative functions you can perform with your photos and videos in CyberLink MediaShow.

Using Your Photos

CyberLink MediaShow lets you create several types of media with your photos, including screen savers and slideshow videos that you can burn to a disc.

Creating and Customizing Slideshows

CyberLink MediaShow lets you create and customize a slideshow that includes both your photos and videos. You can select from a number of styles, and then add background music, text and color boards.

To create and customize a slideshow, do this:
1. Select an album, folder, search tag, people or select and hold all of the photos you want to include on the tray.

2. Click the **Create Slideshow** button on the **Home** tab. CyberLink MediaShow displays all the selected photos in the slideshow and in the thumbnail panel along the bottom.

3. Edit the slideshow as follows:
   - use the rotate buttons to orientate the photos as required.
   - select **Add/Arrange** to add and arrange the media in your slideshow as follows:
     - select the **Videos** tab to browse to and add video clips into the slideshow.
     - select the **Photos** tab to browse to and add more photos into the slideshow.
     - select the **Color Boards** tab to add a new slide with a custom background color. Color boards let you insert a break into your slideshow, or you can use them for titles and credits. Select the color of the color board from the color panel, and then click **Add Color Board**.
     - once you are done adding all of your media, arrange the order of all the slideshow’s slides by dragging them to a new position. You can also auto arrange the media by date or name by selecting **[ ]**.
   - select **Design** and then the **Slideshow Style** tab to set the slideshow’s style as follows:
     - select the **Slideshow style** and transitions used between the slides in the slideshow from the list.
     - select the **Aspect ratio** of your slideshow. It is recommended that it is set to the same aspect ratio as the majority of the media in the slideshow.
   - the **Enable slideshow opening page** option adds an opening page and text at the beginning of the slideshow.

---

**Note:** if the slideshow opening page was previously disabled, to enable it you must select **Enable slideshow opening page**, back out of the slideshow editor, and then reenter to add the slideshow opening page.

- select **Use description as default text** for CyberLink MediaShow to use the media file’s description when adding text to a slide.
- enter in the **Display duration** of each slide or photo. This does not alter the length of any video clips included in the slideshow.
Note: you can customize the transition used on each slide, and its duration, by selecting a slide and then clicking the Properties button in the slideshow editor.

- select Design and then the Slideshow Music tab to set background music for the slideshow. See "Slideshow Music Settings" on page 47 for detailed information.
- select Add Text to include a text description on a slide. Use the keyboard to enter or modify the default text on all of the slides in your slideshow.
  - To modify the text font properties select A.
  - To modify the effect the text uses during the slideshow, select ．
  - Select  to preview all of the text on the slide or  to remove it.
- select Properties to customize the transition used and the duration of the selected slide, which can differ from those set for the entire slideshow. For videos in the slideshow, use the slider to adjust the level of the background music and the video's audio when the video is displayed. Drag the slider all the way to the Music side if you want to completely mute the video's audio in the slideshow.
4. While editing the slideshow, use the playback controls to continually preview your slideshow. Select Save to save it and work on it later.

Setting a Photo as Desktop Background

You can set any of the photos in your library as your desktop's background image. To do this:
1. Click on the photo in your library that you want to add as your desktop background.
2. Click on the Create tab and then on Desktop.
3. Select whether to center, tile or stretch it on your desktop.

Creating a Screen Saver

CyberLink MediaShow lets you create a screen saver with your photos. To create a screen saver, do this:
1. Select and then click  to hold (on the Tray) all the photos in your library that you want to include in your screen saver.
2. Click on the **Create** tab and then on the **Screen Saver** button.
3. Click the **Yes** button. CyberLink MediaShow creates your screen saver and sets it as your default screen saver.

---

**Note:** CyberLink MediaShow places the photos in the **Screen Saver** album within **Albums**. You can instantly add new photos to the screen saver by dragging and dropping them here.

---

To modify the preferences for your created screen saver, including the addition of background music, see "Screen Saver Preferences" on page 44.

### Creating a Slideshow Movie

You can instantly create a slideshow movie file using your photos, which is then saved in your video library.

To create a slideshow movie, do this:

1. Select and then click 🎥 to hold (on the Tray) all the photos in your library that you want to include in your slideshow movie.
2. Click on the **Create** tab and then on the **Movie** button.
3. Within the Slideshow style window:
   - **Style:** select the style for your slideshow movie. See "Slideshow Preferences" on page 44 for a detailed description of the slideshow styles.
   - **Speed:** select the speed of your slideshow movie, or how quickly the slideshow advances to the next photo.
   - **Change Slideshow Opening:** if you select the cell slideshow style, click this button to enter a title and your name on the slideshow opening page.
4. Within the Slideshow background music window, set the background music for the slideshow. See "Slideshow Music Settings" on page 47 for detailed information.
5. Within the Save As window, select the production options for your slideshow video file. See "Producing Videos" on page 29 for detailed instructions.
6. Click on **OK** to create your slideshow and output it as a movie file. The created movie is added into your video library.

### Printing Your Photos

With CyberLink MediaShow you can print out your photos on your printer in a variety of sizes or send them directly to an online printing service.
Printing Photos on a Printer

CyberLink MediaShow lets you print out copies of your photos in a variety of sizes, acting like a virtual dark room.

To print photos, do this:

1. Select and then click (on the Tray) all of the photos that you want to print, click on the Create tab, and then click on Print. The Print window displays.

2. Set your printing options as follows:
   - **Layout**: select how you want the selected photos printed out. You can select from a variety of sizes, allowing you to print one or more photos out on a single piece of paper.
   - **Printer**: select the printer from the drop down menu that you want to print your photos out on.
   - **Fit**: select whether to shrink the size of the photo to fit the printing area or have CyberLink MediaShow automatically crop the photo to fit it.
   - **Printer Setup**: click this button to set specific printer options, such as page layout and whether you want to print double-sided. The options available depend on the printer that is connected to your computer.
   - **No. of copies per photo**: enter the number of copies for each photo you would like printed out in the field provided.

3. Click on the Print button to begin printing your photos.

Ordering Photo Prints

You can send your photos from within CyberLink MediaShow directly to an online provider, if you would like to order prints and other products.

**Note**: this feature is only available in certain countries.

To order prints from an online provider, do this:

1. Select and then click (on the Tray) all of the photos that you want to send, click on the Create tab, and then on Order Prints.
2. Select the country where you are located from the list.
3. Select the online provider from the list that you want to use.
4. After completing the authorization process and uploading your photos to the online provider, go to its web site and complete your order.
Using Your Videos
With CyberLink MediaShow you can turn your video clips into stylish movies in just a few simple steps.

Creating Movies
With the Create Movie function, you step into the editing room and create a finished movie with your videos. You can select from a number of pre-designed movie styles, perform trims on video clips and mix in music with your movie.

To create a movie, do this:
1. Select and then click  to hold (on the Tray) all the videos in your library that you want to include in your movie, click on the Create tab and then on Movie. The Create Movie window displays.

   Note: you may add additional video clips to your movie by clicking on the Add button in the video clip panel.

2. Customize your movie as follows:
   • Click on Trim to remove any unwanted scenes from your video clips. Use the helpful tips on the user interface for a detailed description on how to use the trim function.
   • Click on Style to select a movie style template that fits your video. Selecting a style template provides pre-designed opening sequences, transitions and effects to automatically generate a professional-looking movie.
   • Click on Mix and then on + to add background music to your movie. Use the Sound mix slider to set the audio level between the added background music and the video's original audio.

3. Click on the Movie button next to the playback controls to generate and preview a version of the finished movie.

   Note: CyberLink MediaShow will generate a new version of the move every time any of the noted functions are changed.

4. When you are satisfied with your movie, click the Produce Movie button to output a finished version to a video file. Within the Save As window, select the
production options for your slideshow video file. See "Producing Videos" on page 29 for detailed instructions.

5. Click on **OK** to create your slideshow and output it as a movie file. The created movie is added into your video library.

**Movie Settings**

Movie Settings let you input your movie's title, set the size of the movie, and more. It is recommended that you set these settings before you produce your final movie.

Select the **Settings** button within the Create Movie window to configure the settings as follows:

- **Title**: input a title for your movie, which is displayed during the opening.
- **Credits 1, Credits 2**: input text you want to use as part of your movie's closing credits, for example your name or date created.
- **Output**: select **Auto** to let CyberLink MediaShow select the size and aspect ratio for the outputted movie file. Select **Manual** to select the aspect ratio for your movie based on the aspect ratio of the original video clips.

**Producing Videos**

When you are done editing your photos and videos, and creating slideshows and video movies, use CyberLink MediaShow to output your new media into a variety of available formats. You can select from the available file formats, or create your own custom video profile.

To output your video as an MPEG-4 (H.264), MPEG-2 or WMV file, do this:

1. Select the preferred output format by clicking on the corresponding button.
2. Select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the drop-down menu.
3. Enter a name for the converted file.
4. If you are converting your file to an MPEG-4 (H.264) or MPEG-2 file, select the format for the video's audio from the **Audio format** drop-down menu.
5. If required, click on **...** to select a different output folder for the produced file.
6. If your computer supports CUDA/ATI Stream technology, select **Enable CUDA/ATI Stream to maximize performance** to reduce the time it takes to create your video file.
7. Click **OK** to start the output.

To output your video to format with a custom profile, do this:
1. Click on 📀 and then click on New to open the Custom window.
2. Enter a Profile name for the custom profile in the field provided.
3. Select the file format for the converted file from the Format drop-down menu.
4. If applicable, select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the Resolution drop-down menu.
5. If applicable, select the video’s Bitrate or quality from the drop-down menu.
6. If applicable, select the audio compression you want applied to the video’s audio from the Format drop-down menu.
7. If applicable, select the audio compression rate or quality of the video's audio from the Bitrate drop-down menu.
8. Click OK to return to the Convert window.
9. Enter a name for the converted file.
10. If required, click on ⋮ to select a different output folder for the converted file.
11. If your computer supports CUDA/ATI Stream technology, select Enable CUDA/ATI Stream to maximize performance to reduce the time it takes to create your video file.
12. Click OK to start the output.

Note: after you produce the video files, CyberLink MediaShow saves the custom profile you created so you can use it the next time you want to convert video files. It is available within Custom Profiles.
Converting Videos into Other Formats

CyberLink MediaShow lets you convert video files into other formats, both within in the videos module or in the video converter module. You can access the video converter module* by selecting Convert on the CyberLink MediaShow launcher.

Note: *optional feature in CyberLink MediaShow. Check the readme file for detailed versioning information.

To convert a video into another format within the videos module:
- right-click on the video file you want to convert and select Convert to. See "Producing Videos" on page 29 for detailed information on using the Save As window.
- right-click on the video file you want to convert and select Convert to iPod Compatible File. See for "Converting for use on an iPod or iPhone" on page 33 detailed information.
right-click on the video file you want to convert and select **Convert to PSP/PS3 Compatible File**. See for "Converting for use on a Sony PSP/PS3" on page 34 detailed information.

**Using the MediaShow Video Converter**

CyberLink MediaShow Video Converter* is a handy little module that lets you quickly convert your video files into other formats, so that you can watch them on an iPod, iPhone, PSP, PS3, Zune, or Xbox. You can also convert files into many other popular formats, or into high quality files that you can then upload to YouTube. To open the video converter, select **Convert** on the CyberLink MediaShow launcher.

**Note:** * optional feature in CyberLink MediaShow. Check the readme file for detailed versioning information.

**Importing and Playing Video Files**

The first step is to import all of the video files that you want to convert into the video converter. Once in the main window, you can play them back using the video player.

To import and play your videos, do this:

1. Click on the **Import Videos** button to import individual video files, or select **Import Folder** to import all videos in a specific folder.
2. Browse to and select all of the videos you want to import and convert, and then click on the **Open** button.
3. To play back a video, double-click on it or right-click on a video and then select **Play**.
4. Use the available playback controls to pause the video, adjust the volume, or play the previous/next selected video file.
5. Click to return to the main window, or press the Esc or Backspace button on your keyboard.

**Tips:**

- You can import and convert video files in the following formats: AVI, MPG, MPEG, MOV (H.264), WMV, MP4, DVR-MS, TS, ASF, M2TS, MTS, DV-AVI, WTV.
- You can convert videos files into the following formats: WMV, MPEG-2, MPEG-4 (H.264), M2TS.
Chapter 3: Creating New Media

- Use the slider to dynamically resize the video thumbnails.
- The video converter can convert up to four video files simultaneously. To set the **Maximum concurrent file conversions** for the video converter, click on and then select **Preferences**.

**Converting for use on an iPod or iPhone**

You can convert all of your current videos into files that you can then play on an iPod or iPhone. Once converted, the video converter can import the converted videos into iTunes if it is installed on your computer.

To convert files for use on an iPod or iPhone, do this:

1. Select all of the imported videos in the video converter window that you want to convert.
2. Click on the **Apple Devices** button.
3. Select which Apple device you want to play the converted video files on from the drop-down menu.
4. Select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the drop-down menu.
5. If you are only converting one file, enter a name for the converted file.
6. If required, click on to select a different output folder for the converted file.
7. If iTunes is installed on your computer, select the **Import the converted files into your iTunes library** option if you want to import the files into iTunes after conversion.
8. If your computer supports CUDA/ATI Stream technology, select **Enable CUDA/ATI Stream to maximize performance** to reduce the time it takes to convert your video file.
9. Click **OK** to start the conversion.
10. If you previously selected **Import the converted files into your iTunes library**, click the **Add to iTunes** button to import the files into iTunes. Otherwise click on **OK** to return to the video converter main window.

**Note:** if iTunes is not currently installed on your computer, the video converter will just place the converted file into the specified output folder.
Converting for use on a Sony PSP/PS3
You can convert all of your current videos into files that you can then play on a
Sony PSP or PS3.
To convert files for use on a Sony PSP or PS3, do this:
1. Select all of the imported videos in the video converter window that you want
to convert.
2. Click on the **Sony Devices** button.
3. Select whether you want to play the video file on a PSP (PSP-Video) or PS3 from
the drop-down menu.
4. Select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the
drop-down menu.
5. If you are only converting one file, enter a name for the converted file.
6. If required, click on ![ ] to select a different output folder for the converted
file.
7. If your computer supports CUDA/ATI Stream technology, select **Enable CUDA/
ATI Stream to maximize performance** to reduce the time it takes to convert
your video file.
8. Click **OK** to start the conversion.
9. Click **OK** to return to the main window.

Converting for use on a Microsoft Zune/Xbox
You can convert all of your current videos into files that you can then play on a
Microsoft Zune or Xbox.
To convert files for use on a Microsoft Zune or Xbox, do this:
1. Select all of the imported videos in the video converter window that you want
to convert.
2. Click on the **Microsoft Devices** button.
3. Select whether you want to play the video file on a Zune or an Xbox from the
drop-down menu.
4. Select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the
drop-down menu.
5. If you are only converting one file, enter a name for the converted file.
6. If required, click on ![ ] to select a different output folder for the converted
file.
7. Click **OK** to start the conversion.
8. Click **OK** to return to the main window.

**Converting to Other Formats**
You can convert videos into other formats, including WMV, MPEG-2, and MPEG-4 (H.264). Use the same steps as when outputting slideshows and movies to video files. See "Producing Videos" on page 29 for more information.

**Creating and Using Custom Profiles**
When converting video files to other formats, you can create your own custom video profile for conversion. Use the same steps as when outputting slideshows and movies to video files. See "Producing Videos" on page 29 for more information.

**Converting to High Quality Files for Uploading to YouTube**
You can convert all of your current videos into high quality files and then upload them directly to YouTube.
To convert files for use on YouTube, do this:
1. Select all of the imported videos in the video converter window that you want to convert.
2. Click on the **YouTube** button.
3. Select the preferred resolution and aspect ratio (4:3 or 16:9) for the file from the drop-down menu. If your original video is 16:9, select the 1280x720 16:9 option to ensure your video uses YouTube's full video window.
4. If you are only converting one file, enter a name for the converted file.
5. If required, click on to select a different output folder for the converted file.
6. Select the **Upload converted files to YouTube** option if you want CyberLink MediaShow to upload the files to your YouTube account after conversion.
7. If your computer supports CUDA/ATI Stream technology, select **Enable CUDA/ATI Stream to maximize performance** to reduce the time it takes to convert your video file.
8. Click **OK** to start the conversion.
9. Once the conversion process is complete, click the **Upload to YouTube** button to upload your video (or **OK** if you didn't want to upload after conversion).
10. Follow the detailed instructions in the Upload to YouTube wizard and then click **Upload** to finish.
11. Once uploaded, click **View Video** to view your video on YouTube.
12. Click **OK** to return to the main window.
Chapter 4:

Sharing and Burning Media to Disc

This chapter outlines the ways you can share all of your media with friends, family and the world. It also goes through the process of burning your media to professional looking discs with menus.

Sharing Your Media

CyberLink MediaShow lets you e-mail photos and videos directly from your library, to your friends and family. You can also upload your media to Flickr, Facebook or YouTube.
E-mailing Photos and Videos

You can e-mail one or more media files in the library to your friends and family from within the photos or videos module of CyberLink MediaShow.

To e-mail media to your friends, do this:

**Note:** CyberLink MediaShow uses your computer’s default mail client to e-mail photos and videos, if available. The e-mail feature does not work with web mail applications, such as Hotmail or Gmail. To change the e-mail account that CyberLink MediaShow uses, please go to your e-mail application (such as Microsoft Outlook, Outlook Express, etc.) and reset/change your e-mail account settings.

1. Select and then click \( \text{_hold} \) (on the Tray) all the photos or videos in your library that you want to e-mail.
2. Click on the **Share** tab and then on the **E-mail** button. CyberLink MediaShow launches your default mail client and attaches the photos or videos to the e-mail message.

**Note:** if your computer does not have a default mail client configured, the e-mail feature may not work from within CyberLink MediaShow.

3. Proceed to complete the sending of the e-mail.

**Note:** for information on configuring the settings for e-mailing photos and videos, see "E-mail Preferences" on page 43.

Uploading Photos to Flickr

You can upload photos from the library directly to the Flickr photo sharing web service.

To upload photos to Flickr, do this:

1. Select and then click \( \text{hold} \) (on the Tray) all the photos in your library that you want to upload to Flickr.
2. Click on the **Share** tab and then on the **Flickr** button. The Upload to Flickr wizard displays.
3. Follow the detailed instructions in the wizard and then click **Upload** to finish.

---

**Note:** if you do not have a Flickr account, you must register first before proceeding with the authorization.

---

4. Click the **Done** button once your photos are uploaded.

## Uploading Photos to Facebook

You can upload photos from the library directly to your Facebook page.

To upload photos to Facebook, do this:

1. Select and then click ![ acquisition icon ] to hold (in the Tray) all the photos in your library that you want to upload to Facebook.
2. Click on the **Share** tab and then on the **Facebook** button. The Upload to Facebook wizard displays.

---

**Note:** after clicking the **Authorize** button, you must log in to your Facebook page within your browser, and then return to the upload wizard to complete the authorization process for uploading photos to Facebook. If you do not have a Facebook account, you must register first before proceeding with the authorization.

---

3. Follow the detailed instructions in the wizard and then click **Upload** to finish.
4. Click the **Done** button once your photos are uploaded.

## Uploading Videos to YouTube

You can upload videos from the library directly to the YouTube video sharing web service.

To upload a video to YouTube, do this:

1. Click on the video in the media window that you want to upload to YouTube.
2. Click on the **Share** tab and then on the **YouTube** button. The Upload to YouTube wizard displays.
3. Follow the detailed instructions in the wizard and then click **Upload** to finish.
Note: if you do not have a YouTube account, you must register first before proceeding with the authorization.

4. Click the Done button once your video is uploaded.

Uploading Videos to Facebook

You can upload videos from the library directly to your Facebook page.

To upload a video to Facebook, do this:
1. Click on the video in the media window that you want to upload to Facebook.
2. Click on the Share tab and then on the Facebook button. The Upload to Facebook wizard displays.

Note: after clicking the Authorize button, you must log in to your Facebook page within your browser, and then return to the upload wizard to complete the authorization process for uploading a video to Facebook. If you do not have a Facebook account, you must register first before proceeding with the authorization.

3. Follow the detailed instructions in the wizard and then click Upload to finish.
4. Click the Done button once your video is uploaded.

Creating and Burning Discs

You can use CyberLink MediaShow to create professional looking discs that contain your photos and videos. To launch the create disc module, select the Disc button on the CyberLink MediaShow launcher. If within the photos or videos module, click on the Create tab and then on Disc to launch the create disc module.

Create Disc Window

The Create Disc window provides you with an easy to use wizard that guides you through the creation of your disc.
Note: before you begin creating your disc, you may want to configure your Create Disc settings. See "Create Disc Settings" on page 46 for more information.

Inputting Your Title
The title field allows you to enter a title description for your disc that displays on the main menu page. Simply input a desired title in the field provided.

Selecting a Style
CyberLink MediaShow provides you with the option of selecting from a number of stylish, pre-designed disc menus. These menus are already customized for you and may include such features as motion and menu music. To select a menu template, just click its thumbnail.

Note: You can download and import additional disc menu templates from DirectorZone.

Select the icon within the style section to browse for and download menu templates. Select to import downloaded templates into CyberLink MediaShow.

Adding Videos
If required, you can add videos to your disc, as follows:
1. Click on the Videos tab on the left of the window.
2. Browse through your library and select all the videos you want to include on your disc.
3. Either drag and drop them into the Videos section or use the add buttons.

Adding Photos
If required, you can add photos to your disc. Once added to your disc, they are organized into a slideshow. To add photos to your disc, do this:
1. Click on the Photos tab on the left of the window.
2. Browse through your library and select all the photos you want to include on your disc.
3. Either drag and drop them into the Photos section or use the add buttons.
4. Click the Style & Music button to customize your slideshow as follows:
Slideshow style: Select one of the following slideshow styles from the drop down menu: Fading, Motion, Cell (see the Slideshow Style section in "Slideshow Preferences" on page 44 for a detailed description of each slideshow style). Select the Speed the pictures in the slideshow will be displayed from the drop down menu.

Change Slideshow Opening: If you select the cell slideshow style, click this button to enter a title and your name on the slideshow opening page.

Background music: Set the background music for the slideshow. See "Slideshow Music Settings" on page 47 for detailed information.

5. Click on OK to return to the Create Disc window.

Burning Your Disc
The final step for your production is to click the Burn button to begin burning your media to disc. Before you proceed, use the Preview function to ensure your disc is exactly the way you want it.

Saving and Opening Existing Disc Projects
When you are creating your disc, you don’t need to finish it all at once. At any time you can Save your disc project and then Open it to finalize it later.
Chapter 5:

Preferences and Settings

This chapter outlines the preferences for CyberLink MediaShow and various settings used throughout the program.

MediaShow Preferences

To open and set your preferences when within the videos or photos module, click on and then select Preferences from the menu.

General Preferences

On the General tab, set the preferences for the CyberLink MediaShow program, such as user interface language and default import folder.

- **Display tool tips**: select this option to display hints when your mouse hovers over certain features and buttons within the program.
- **Enable video buffer mode**: select this option to enable a video buffer when viewing your videos. This feature is ideal when watching high quality videos on older computers, as pausing the video allows the entire video to pre-load in the playback window.
- **User interface animation effects**: select this option to enable animation effects within the program. You may want to deselect this option to improve computer performance, if necessary.
- **Language options**: select your preferred user interface language for the program. You must restart the program for the changes to take effect.
- **Launcher options**: select which images display within the CyberLink MediaShow launcher.
- **Save imported photos and videos to**: set the default location where imported media is saved.
- **Maximum simultaneous file conversions**: set the maximum number of videos that CyberLink MediaShow can convert at one time.

E-mail Preferences

On the E-mail tab, set the output preferences when e-mailing media.
• **Reduce size of large photos before e-mailing to**: use this option to change the resolution of photos that exceed the selected size, before e-mailing.

• **Reduce size of large videos before e-mailing to**: use this option to change the resolution of videos that exceed the selected size, before e-mailing.

### Slideshow Preferences

On the **Slideshow** tab, set the default style and background music when viewing slideshows.

**Slideshow style**

Select one of the following slideshow styles from the drop down menu:

- **Fading**: adds a fade in and fade out effect between the photos in your slideshow.
- **Motion**: adds pan and zoom effects to make your slideshow more engaging with the appearance of motion.
- **Cell**: displays pictures in a creative, movie like slideshow, complete with credits. If you choose to include background music, CyberLink MediaShow uses the **Magic Slideshow** technology to display the photos dynamically along to the beat of the music.

- **Change Slideshow Opening**: if you select the cell slideshow style, click this button to enter a title and your name on the slideshow opening page.

**Background music**

- **Play music during slideshow (WMA/MP3)**: select this option to enable background music during the playback of a slideshow.

**Select folder or audio file for background music**

- Select an audio file or the folder that contains the music, in the WMA or MP3 format, you want to use in the slideshow. Select a folder if you want multiple songs in the slideshow.

### Screen Saver Preferences

You can set the background music for your screen saver and also set the its style on the **Screen Saver** preferences tab.

**Screen saver style**

Select one of the following screen saver styles from the drop down menu:
Chapter 5: Preferences and Settings

- **Fading**: adds a fade in and fade out effect between the photos in your screen saver.
- **Motion**: adds pan and zoom effects to make your screen saver more engaging with the appearance of motion.
- **Cell**: displays your pictures in a creative, movie like slideshow, complete with credits. If you choose to include background music, CyberLink MediaShow uses the Magic Slideshow technology to display the photos dynamically along to the beat of the music.
- **Change Slideshow Opening**: if you selected the cell screen saver style, click this button to enter a title and the name of the screen saver author.

**Background music**

- **Play music during screen saver (WMA/MP3)**: select this option to enable background music during the playback of a screen saver.

**Select folder or audio file for background music**

- Select an audio file or the folder that contains the music, in the WMA or MP3 format, you want to use in the screen saver. Select a folder if you want multiple songs in the screen saver.

**Library Preferences**

On the Library tab, add folders that contain media into CyberLink MediaShow. When you add a folder, it is scanned for new media automatically every time you launch the program.

- click on the + button to add a folder to CyberLink MediaShow. CyberLink MediaShow scans the folders in the list every time the program is launched and automatically loads all of the new media into the library.

**Import options**

- **Ignore photo files less than 50 KB**: select this option if you do not want to import photo files that are less than 50 KB in size.
- **Ignore video files less than 500 KB**: select this option if you do not want to import video files that are less than 500 KB in size.

**View Preferences**

CyberLink MediaShow provides you with some viewing preferences for the program. Here you can select the user interface skin color and set the default size of the thumbnails in the media window.
To set the view preferences, click on **View** tab to customize the following options:

- **Thumbnails**: select the size of the thumbnails that are displayed in the media window.
- **Captions**: select the type of caption that is displayed underneath your media in the media window.
- **Skin**: select the color of the user interface skin for CyberLink MediaShow.
- **Display Hidden**: use this option to display media and folders that were previously hidden from view within CyberLink MediaShow.

### Create Disc Settings

Before you burn a disc, be sure to configure the disc settings. To do this, click on **Settings** in the Create Disc window and then configure the settings as follows:

**Disc Selection**

- **Optical drive**: select the burning device from the drop down menu that you want to use to burn your disc.
- **TV format**: select the TV format (NTSC or PAL) of the video that is burned to the disc. This format should correspond with the region in which you plan to play the disc.
- **Audio format**: select the desired audio encoding for your outputted disc’s audio.
- **Aspect ratio**: set the aspect ratio for the video. For DVDs you may select between 4:3 or 16:9.
- **Quality**: select the video quality of disc’s video. The video quality settings offer different bit rates, resulting in files of different sizes. The higher the quality of the video, the larger the resulting file and the shorter the length of video that can fit onto a disc.
- **Disc capacity**: displays the available space on the disc currently inserted in the selected optical drive (burning device).

**Preferences**

- **Display TV safe zone in the Preview window**: select to display a box that indicates an area that will fit on most TVs, when previewing your completed disc. Utilizing this feature ensures that menu items are within the display range of most TVs.
- **Burn disc without a menu**: select this option to have the video on your disc play automatically when the disc is inserted into a disc player.
- **Auto menu timeout**: select this option for the video on your disc to play automatically after displaying the menu for a short duration.
Common Used Settings
The following are common settings within CyberLink MediaShow that are used throughout the different modules.

Slideshow Music Settings
- select **Play music during slideshow** to enable music that plays in the background when viewing the slideshow.
- select **Match slideshow length to music** for the length of the slideshow to match the total duration of the music selected.
- select the **Set folder or select a file as background music** option to select a specific audio file or a whole folder that contains music as the background music. Select a folder if you want to use more than one song in your slideshow.
- select the **Select and arrange background music** option to completely customize the background music in your slideshow. Use the button to add songs to the list and then set the order using and .
Chapter 6:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Please take advantage of one of CyberLink’s free technical support options:

- consult the user’s guide or the online help installed with your program.
- refer to the Knowledge Base in the Support section of the CyberLink web site.

http://www.cyberlink.com/prog/support/cs/index.do

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered activation key (Your activation key can be found on the CD cover, the Box cover, or in the email received after you purchased CyberLink products on the Cyberlink store).
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.
- the version of Windows installed on your system.
- hardware devices on your system (capture card, sound card, VGA card) and their specifications.
- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture).
- a detailed description of the problem and under what circumstances it occurred.
# Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

**Note:** you must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs and a user community forum, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
</table>
Index

A

Add
  face tag 14
  folder 45
  search tags 12, 21
  text 25
Albums 10
  add media 10
  create 10
  favorites 11
  screen saver 25
  tools 10
Animation 43
Antique 21
Arrange slides 24
Aspect ratio 46
ATI stream 29, 33, 34, 35
Audio
  format 46
  noise reduction 20

B

Background music 42, 44, 45
  settings 44, 47

C

Captions 46
  slideshow 17
Capture video 9
Cell 42, 44, 45
Color boards 24
Compare 18
Contrast 19, 20
Controls 16
Convert 31
  simultaneous 43
Create
  disc 3, 40
  folder 11
  movies 28
  new album 10
  new tag 12
  screen saver 25
  slideshow movie 26
Crop 19
CUDA 29, 33, 34, 35
Custom profiles 30

Balance 19
Batch convert 33
Bitrate 30
Black & white 20
Brightness 19, 20
Buffer 43
Burn 37, 40, 42, 46
D
Description 21
Desktop background 25
DirectorZone 41
Disc
  format 51
Discs
  add photos 41
  add videos 41
  aspect ratio 46
  burn 42
  capacity 46
  create 3, 40
  quality 46
  style 41
  title 41
  TV format 46
Display captions 17
Display hidden 46
Download 41
DV camcorder 9

E
Edit 18, 20
  description 21
  fix photos 19
  fix videos 20
  rotate media 18
  trim videos 19
  undo 21
Edit log 21
Effects 20
E-mail 38

F
Facebook 39, 40
Faces 13
  tag 13, 14
Fading 42, 44, 45
Favorites 11, 17
  albums 10
Features 1
Fine tune 20
Fix
  photos 19
  videos 20
Flickr 38
Focal B&W 21
Folders 11
  create 11
  display 46
  hide 46
  move to new 12
  preferences 45
  separate 11, 12
  tools 11
Format 30, 51

G
Glow 21

preferences 43
H
H.264 35
HDV camcorder 9

I
Import 8, 32
download menu 41
folder 43
PowerPoint files 9
video 9
iPhone 32, 33
iPod 31, 32, 33
iTunes 33

L
Language 43
Launcher 4
options 43
Library 8
import media 8
preferences 45
search 15
Lighting
auto fix 19, 20

M
Magic slideshow 44, 45
Manage 7

Matte 20
Media
display 46
hide 46
manage 7
resize 15
search for 15
Media window 15
MediaShow
modules 3
new features 1
system requirements 4
upgrade 3
versions 2
Menus 41, 46
download 41
Mix 28
Modules 3
Motion 42, 44, 45
Movies 28
MPEG-2 29, 35
MPEG-4 29, 35
Music
screen saver 45
settings 47
slideshow 44

N
NTSC 46

O
OEM versions 2
Optical drive 46
Order prints 27
Overview 1

P

PAL 46
People
  add 13
  edit 13, 14
  search for 15
Photos 3
  add to disc 41
  compare 18
  create slideshow 24
  desktop 25
  display 46
  edit 20
  edit description 21
  effects 20
  e-mail 38
  fine tune 20
  fix 19
  hide 46
  import 8
  import folder 43
  order prints 27
  printing 27
  produce video 29
  reduce size 44
  rename 21
  resize 21
  resize thumbnails 15
  rotate 18
  screen saver 25
  search for 15
share 37
slideshow movie 26
upload 38, 39
view 16
Play back
  slideshow 16
  videos 17
PowerPoint files
  import 9
Preferences 43
  e-mail 43
  general 43
  library 45
  screen saver 44
  slideshow 44
  view 46
Print 27
Produce 29
Profiles 30
Properties 25
PS3 32, 34
PSP 32, 34

Q

Quality 46

R

Red-eye 19
Rename 21
Resize 21
Resize thumbnails 15
Resolution 30
Rotate 18

S

Saturation 20
Screen saver 25
  background music 45
  magic slideshow 45
  opening 45
  preferences 44
  style 44
Search 15
Search tags 12, 21
Sepia 20
Settings 43
  background music 47
  burn 46
  create disc 46
  movie 29
Shaky video 20
Share 37
  e-mail 38
  Facebook 39, 40
  Flickr 38
  YouTube 39
Sharpness 20
Skin color 46
Slideshow
  add media 24
  background music 42, 44
  cell 42, 44
  create 24
  design 24
  display captions 17
  fading 42, 44
  magic slideshow 44
  motion 42, 44
  movie 26
  opening 17, 42, 44
  playback controls 16
  preferences 44
  produce 29
  properties 25
  select style 42
  speed 42
  style 44
  style description 42
  text 25
Soft focus 21
Straighten 19
System requirements 4

T

Tag faces 13, 14
Tags 12, 21
  add media 12
  create 12
  tools 12
Text 25
Thumbnails
  resize 15
  size 46
Tint 21
Tool tips 43
Tray 16
Trim 19, 28
TV format 46
TV safe zone 46
| U       | reduce size 44  
|         | rename 21       
|         | resize thumbnails 15  
|         | rotate 18       
|         | search for 15   
|         | share 37        
|         | trim 19, 28     
|         | upload 39, 40   
|         | Vignette 20     |
| V       | Video converter 3, 32  
|         | Video noise, reduce 20  
|         | Videos 3         
|         | add to disc 41   
|         | buffer 43        
|         | convert 31, 32   
|         | create movies 28 
|         | custom profile 30|
|         | display 46       
|         | display captions 17 |
|         | edit 20          
|         | edit description 21 |
|         | e-mail 38        
|         | fine tune 20     
|         | fix 20           
|         | hide 46          
|         | import 8, 32     
|         | import folder 43 |
|         | playback 16, 32  
|         | playback controls 16 |
|         | produce 28, 29   
|         | quality 46       |
| W       | White balance 20 
|         | WMV 29, 35       |
| X       | Xbox 32, 34      |
| Y       | YouTube 35, 39   |
| Z       | Zune 32, 34      |